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Introduction
VuePrint is a Windows 3.1 program that lets you display and print graphics files that use the 
GIF, JPEG, PCX, DIB, and BMP graphics formats, and play sound files that use WAV, MID, and 
MCI sound formats. VuePrint supports all graphics displays and printers that operate with the
Microsoft Windows 3.1 operating environment, using at least a 386 microprocessor.

The two key features of VuePrint are speed and ease of use. VuePrint is more than twice as 
fast as most other JPEG viewers, and is able to scale images to full-screen more than five 
times as fast as other viewers. VuePrint will scale images to fill a window automatically, 
without distorting the image shape. It has a cropping feature to remove borders from around
images, full support for playing sounds and controlling multimedia devices such as CD 
players and videodisks. While VuePrint has many features, all are integrated in an easy to 
use menu system.

VuePrint lets you display, print, and play files you select while running the File Manager. It 
also supports dragging a file from the File Manager and dropping it into the VuePrint window.
VuePrint is fully integrated with the Windows Program Manager, giving full control over all 
options from the command line. It can also be used as a viewer subsystem for other 
programs such as the Internet Mosaic program.

VuePrint automatically detects the display type, and uses a pattern of dots (dither) on the 
display when there are fewer colors available than the image requires. If the Auto Dither 
option is selected, dithering is used when the image uses colors that are not available.    
Otherwise, dithering is used when the display has fewer than 256 possible colors.    This lets 
you use VuePrint on all laptop computers, as well as run multiple copies of VuePrint at the 
same time.    Even when multiple pictures require more colors than are available, VuePrint 
will make a best effort to display the images.    When printing, dithering is only used for 
images with more than 8 bits per pixel - otherwise the standard dithering provided by 
Windows is used.

To use VuePrint, you will need a personal computer that is running Microsoft Windows 
version 3.1 or higher. You will also need at least a 386 microprocessor. VuePrint will work 
with any Windows printer and display, including Hercules, EGA, 16-color, 256-color, 16-bit 
color, and 24-bit color displays.

There will be 286 and Win32s versions of VuePrint available in the near future. Check your 
favorite site for availability.



Registering
VuePrint is distributed as shareware, and may be evaluated without charge for 15 days. 
VuePrint is available from on-line systems such as America Online, CompuServe, Internet ftp 
archives, and many BBS systems. Because it is distributed electronically, new releases are 
free to registered users. You can decide when to upgrade to a new version of VuePrint, and 
can download this new version at any time.

The $40.00 registration fee can be paid two different ways:

1. If you have a CompuServe account, you can use the on-line software registration 
service. This service will charge your account $40, and will automatically send an e-
mail notifying me that you have registered. To use this service, go to the SWREG area
on CompuServe, and register program #1883 (VuePrint). I will respond by e-mail with 
a permanent serial number for your version of VuePrint. 

2. If you do not have a CompuServe account, send your e-mail address with $40.00 in
cash or check (any currency is acceptable), to: 

Ed Hamrick
4171 E. Rockledge Rd.
Phoenix, AZ 85044-6771

If you include your e-mail address with your letter, I will respond with a serial number by e-
mail. Otherwise, it may take some time to respond by surface mail. In case you do not have 
access to e-mail, or you need a temporary serial number immediately, I have set up a 24-
hour phone number that you can call to get a temporary serial number. Call (602) 759-3966 
to get a temporary serial number that will disable the registration reminder for an additional 
15 days. Note that this temporary serial number can only be entered once, and additional 
temporary serial numbers obtained by phone can not be entered into VuePrint. (If I am on 
vacation or out of town, this temporary serial number will disable the registration reminder 
for a longer period.)

When you register VuePrint, you will receive assistance via e-mail with any problems you 
may encounter. You will also receive a serial number identifying your copy of VuePrint. This 
serial number is also valid for VueSaver - a fast JPEG/GIF Screen Saver for Windows 3.1. (A 
future release of VuePrint will incorporate the functions of VueSaver.)

Note that you will not receive a diskette or a manual in the mail when you register, since you
already have the complete VuePrint program, including the available documentation (this 
help file). Each release of VuePrint is contained in a single .ZIP file. This .ZIP file contains two
files - VUEPRINT.EXE (the program) and VUEPRINT.HLP (the help file).

Once the 15 day evaluation period ends, VuePrint displays a reminder that the evaluation 
period has ended, and a request to register the program. This reminder was carefully 
designed to not interfere with further evaluation of the program past the 15 day period - all 
functionality is still enabled after the evaluation period.



File Formats
VuePrint reads three types of files:

Image files (.GIF, .JPG, .PCX, .BMP, .DIB)

Sound files (.WAV, .MID, .MCI)

Slide Show files (.SLI)

A file with one of the above image file extensions is automatically recognized by the first two
bytes in the file. If the first two bytes are not recognized, the software checks to see if the 
file has an extra 128 byte Macintosh header, and bypasses this header.    For instance, a GIF 
file with a .DIB extension and a Macintosh header will be read correctly, but a GIF file with 
a .DAT extension will not be recognized.

Sound and Slide Show files are recognized by their extensions.

VuePrint will read both GIF 87a files and GIF 89a files. The only GIF 89a attribute that is used
is transparency, the other GIF 89a extensions (such as text overlays) are ignored. Multiple 
Image GIF files are supported, and the image that is displayed is the composite of all the 
multiple image segments.

VuePrint reads JPEG (.JPG) files that use the JFIF format.

PCX files that are version 3.0 or less are supported. The CGA color palette is ignored.

All BMP and DIB bitmap formats are supported, including OS/2 bitmaps.

Standard WAV and MID (MIDI) files are supported. You need an asynchronous sound driver to
play them, since MCI commands are used to play them (the PC speaker driver will not work).

MCI files contain MCI commands. Refer to various Microsoft descriptions of MCI command 
strings for more details. In order for MCI files to interact properly with the slide show feature,
one MCI command should use the notify parameter. When the command completes, VuePrint
will automatically issue the close all MCI command. For example, the following MCI file will 
play track two of an audio CD player, and will continue a slide show after the track 
completes:

# This script plays track two on an audio cd
open cdaudio alias cd
set cd time format tmsf
play cd from 2 to 3 notify

Slide Show files (.SLI) contain a list of files. This list can contain other .SLI files, which can 
refer to other .SLI files, and so on (up to four times). A slide show list is also automatically 
created with you use the File|Open menu to select a single file. A multiple file selection will 
not automatically create a slide show list.



File Manager
VuePrint can be integrated with the Windows File Manager by choosing the Utilities|Install 
VuePrint to associate VuePrint with the Image, Sound, and Slide Show file types.    You can 
use Utilities|Remove VuePrint to disassociate VuePrint and restore the previous associations. 
When VuePrint is installed, you can use the File Manager to double-click on any Image, 
Sound, or Slide Show file, and VuePrint will be automatically started to display (or play) the 
file. VuePrint will also print images chosen in the File Manager.



Program Manager
VuePrint provides a complete command line argument processing system that gives you the 
capability to install different VuePrint icons to do different things. Because the command line
processing is also performed when VuePrint is started from another program, you can use 
VuePrint as a viewing subsystem for other applications. The command line can contain two 
types of arguments - options and file names. File names have complete wildcard support, 
and the additional feature that filenames ending in ... will recursively descend a directory 
tree looking for all Image, Sound, and Slide Show files.

The command line is processed from left to right.    Valid command line options can have the 
following forms:

-name
/name
-name=value
/name=value

If there is no value specified, the value 1 is used.

The names of the options are the same as those in the VUEPRINT.INI option file, and override
the settings in that file. Command line options can be abbreviated, are not case sensitive, 
and the first one matching the command line option is used. There are two additional 
command line options that are not used by the .INI file:

/directory=name
/print

The /directory=name option changes the current drive and directory to name. This is useful 
when VuePrint is used as a subsystem of another program.

The /print option causes every file on the command line to be displayed and then printed.    
Only the first file sets up the printer options, the remainder use the same printer options.    
This lets you do unattended printing of large numbers of image files.



Interrupting
VuePrint has been designed to let you interrupt loading files, since this operation can 
sometimes take some time. The following menu choices (and their keyboard equivalents) 
will interrupt the file loading and cause the command to be executed. Other menu choices, 
keyboard commands, and mouse commands will be executed and then file loading will 
continue.

File|Open
File|Next
File|Previous
File|Random
File|Print
File|Printer Setup
File|Exit
Image|Crop
Image|Copy
Image|Delete
Utilities|Install VuePrint
Utilities|Remove VuePrint
(Dropped files from File Manager)

For example, pressing the X key while a file is being loaded will execute the File|Exit 
command, causing VuePrint to immediately exit.



Options
The following options can be used in the VUEPRINT.INI file and on the command line. Their 
default values, minimum values, and maximum values are:

Option Default  Min  Max
SoundEnable 1 0 1
SoundSynchronous 0 0 1
ColorDisplay 1 0 1
ColorPrinter 0 0 1
WhiteBackground 1 0 1
ShowComments 0 0 1
ShowHistory 0 0 1
AutoScale 1 0 1
AutoCrop 0 0 1
AutoDither 0 0 1
AutoComments 0 0 1
FillWindow 0 0 1
SaveOptionsOnExit 0 0 1
Rotate 0 0 7
JPEGTwoPass * 0 1(see JPEG Menu)
JPEGUseDithering 1 0 1
JPEGUseGreyScale 0 0 1
JPEGBlockSmoothing 0 0 1
JPEGPixelSmoothing 0 0 1
JPEGWriteGIF 0 0 1
RunSlideShow 0 0 1
StopWhenDone 0 0 1
ExitWhenDone 0 0 1
DelayImage 5 0 9999
DelaySound 0 0 9999
Brightness 5 1 9
Contrast 5 1 9
FileIndex 0 0 8
XImage 0 0 999
YImage 0 0 999
WImage 1000 1 1000
HImage 1000 1 1000
MImage 0 -1 1
XComments 0 0 999
YComments 667 0 999
WComments 1000 1 1000
HComments 333 1 1000
MComments 0 -1 1
XHistory 0 0 999
YHistory 667 0 999
WHistory 1000 1 1000
HHistory 333 1 1000
MHistory 0 -1 1
XPrinter 0 0 999
YPrinter 0 0 999
WPrinter 1000 1 1000
HPrinter 1000 1 1000
MPrinter 0 -1 1



The options for controlling window position and the layout on the page when printing are 
designed to be independent of the display resolution.    These values range from 0 to 1000, 
where 1000 is the full width (or height) of the display or printed page.    The option beginning
with M is -1 for a minimized window, 0 for a normal window, and 1 for a maximized window 
(it has no effect for printouts).



Mouse
The left mouse button can be used to select a rectangular subset of an image.    This subset 
of the image is used when displaying and printing an image.    The right mouse button is 
used to move a zoomed-in image within the window (youll see a hand icon when moving).    
A double-click of the right button will select the whole image.

When the left mouse button is clicked, and less than 16 pixels are selected, the image is 
zoomed by a factor of two, centered on the position of the mouse.    If the shape of the 
selected image is considerably taller than the window (or wider than the window), the image
will only be zoomed in height (or width).

If both mouse buttons are pressed at once, the program will exit.



Keyboard
All menu items have a keyboard equivalent.    The key that corresponds to the menu item is 
displayed along with the menu.

In addition, the arrow keys on the keyboard will move a zoomed image.    If the shift key is 
pressed along with an arrow key, the zoomed image will move in screen sized jumps.

Long-running MCI commands can be aborted by pressing Control-Break.



Hints
If you get a display that seems fuzzy (made up of lots of small dots), you probably have your
Windows display adapter configured for 16 colors.    To configure your display adapter for 256
(or more) colors, go to the Program Manager and open the Main window.    Then open the 
Setup window, and choose the Options|Change System Setting menu.    Choose a display 
mode that has 256 (or more) colors, and then press OK.    If you can not find a display mode 
for 256 (or more) colors for your display type, select the last item in the list Other display 
(requires disk from OEM)....    You will have to insert the diskette containing the display driver
for your computer.    This diskette probably came with your computer, or came with your 
display adapter if you bought it separately.

If you have several hard drives, you can set up an environment variable (TMP or TEMP) to 
tell VuePrint where to write temporary files when processing very large JPEG files.

If you have a JPEG file that you suspect is bad, you can still view whatever is present in the 
file by turning off the JPEG|Two Pass option.

You do not have to wait till the screen repaints before starting another command.    The 
screen repaint will be postponed if you press a key or use the mouse.



Limitations
VuePrint reads GIF, DIB, BMP, and PCX files that have a maximum width of 4096.    JPEG files 
can have a maximum width of 2048.    All image files can have a maximum height of 6000.    
An image can take up to 75% of the free memory, 50% for two-pass JPEG decoding.    If an 
image cant fit into the available memory, every other pixel and line is dropped until it fits.    
The JPEG routines will use an additional 1/3 of the available memory when doing two-pass 
decoding, and will use temporary files for additional storage.

If youre using virtual memory, the maximum amount of free memory that VuePrint will use is
3 million bytes.    If you want to override this, set up the environment variable TEMPMEM.    
For instance, if you put SET TEMPMEM=6m in AUTOEXEC.BAT, VuePrint will use 6 million 
bytes of memory for temporary storage.    (You can also use k, K, or M as a suffix.)

The maximum number of files that can be selected in the File|Open is limited to 16384 
characters.

MCI commands can be a maximum of 249 characters long.    The MCI command result can 
also be a maximum of 249 characters long.

Cropping only works when there are 8-bits or less per pixel.

If you set wallpaper to a bitmap that has 24 bits per pixel, Windows will refuse to start up if 
you restart your system with 8 (or fewer) bits per pixel.    If this happens, edit the file WIN.INI 
in the
Windows directory and delete the line wallpaper=vueprint.bmp in the section beginning with
[desktop].

The Utilities|Install VuePrint and Utilities|Remove VuePrint options sometimes do not 
successfully set up and remove the VuePrint icon.    I have not figured out how to make this 
more reliable yet.



Upgrading
You can obtain the latest version of VuePrint from America Online, CompuServe, and the 
Internet.    It is also available on many other on-line services.

America Online: Choose the Go To|Keyword... option and enter Graphics.    Then select 
Recommended Utilities.

CompuServe: Go to the GRAPHSUPPORT Forum, Library 3 (GIF Viewers), and 
download VUEPRI.ZIP.

Internet: anonymous ftp to ftp.cica.indiana.edu, pub/pc/win3/desktop, 
vueprixx.zip (where xx is the version number)
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File Menu
The File menu provides commands to open files, control the display of informational 
windows, control slide shows, print images, and exit the program.

Open opens an image or sound file. You can select multiple files by using 
control-click to add single files, or shift-click to select a range of files. If 
only a single file is opened, the other image and sound files in the 
same directory are added to the slide show list.

Show Comments displays a window containing any comments contained within the 
currently displayed image (up to 100 lines). 

Show History displays a window containing a log of the last 100 VuePrint events 
since the program was started. 

Run Slideshow controls the running of slide shows. The next file in a slide show is 
either the next, previous, or a random file in the list, depending on how
the current file was selected. The delay between image files is 
controlled by the Image|Delay option, and the delay between sound 
files is controlled by the Sound|Delay option. 

Stop When Done stops running the slide show when the last file in a slide show is 
reached. 

Exit When Done exits VuePrint when the last file in a slide show is reached. 

Next loads the next file in the Slide Show list.

Previous loads the previous file in the Slide Show list.

Random loads a random file from the Slide Show list.

Print prints the current image.

Printer Setup displays a printer setup dialog box.

Exit exits VuePrint.



Image Menu
The Image menu provides commands to manipulate the current image.

Zoom In zooms the image by a factor of two.    If the Options|Auto Scale is 
selected, images smaller than the window will be scaled up to fill the 
window.

Crop crops borders off the edges of the image.    A border is detected by 
searching for borders that contain significantly fewer colors than the 
image as a whole.

Zoom Out zooms out by a factor of two.

Rotate rotates the image 90 degrees clockwise.

Mirror mirrors the image horizontally.

Flip flips the image vertically.

Brighter increases the overall brightness of the image.

Dimmer decreases the overall brightness of the image.

More Contrast increases the contrast (gamma) of the image.

Less Contrast decreases the contrast (gamma) of the image.

Delay lets you enter the minimum delay between successive images in a 
slide show.

Reset resets the screen to default zoom factor, rotation, brightness, and 
contrast.

Copy lets you make a copy of the current image file.

Save As Bitmap... saves the currently selected image (rotated and clipped) as a bitmap 
(BMP) file.

Save As Wallpaper saves the currently selected image (rotated, clipped, and dithered) to 
the Windows directory as.VUEPRINT.BMP.    The image is scaled up to 
the size of the screen if the AutoScale option is enabled.    This 
command then sets VUEPRINT.BMP as the desktop wallpaper.

Delete lets you delete the current image file.



Sound Menu
The Sound menu provides commands to manipulate the currently loaded sound. Note that 
the keystroke for each of these options is similar to their counterpart in the Image menu (the
Ctrl key is added).

Enable enables playing sounds.

Synchronous enables playing sounds synchronously.    This is useful if you only have 
a sound driver for the PC speaker, which only allows playing sounds 
synchronously.    Only .WAV files will play using this option.

MCI Command lets you enter an MCI command.

Louder increases the volume.

Softer decreases the volume.

Delay lets you enter the minimum delay between successive sounds in a 
slide show.

Replay replays the current sound.

Copy lets you make a copy of the current sound file.

Delete lets you delete the current sound file.



Options Menu
The Options menu provides commands to manipulate various VuePrint options, and to save 
and restore all options (including window positions).

Color Display enables displaying images in color.

Color Printer enables printing images in color.

White Background sets the image background to white.

Auto Scale automatically scales small images to fill the window.

Auto Crop automatically crops images after loading.    The borders around an 
image are cropped if they contain substantially fewer colors than the 
image as a whole.

Auto Dither automatically dithers images if there is a substantial percentage of the 
picture that can not be represented accurately with the colors that are 
available on the display.

Auto Comments automatically displays the comments window after loading an image 
that contains comments.

Fill Window removes the border and menu bar from the window.    You can toggle 
this on and off by pressing the Escape key.

Save Options save the current setting of all options in VUEPRINT.INI.

Restore Options restore all options from VUEPRINT.INI.

Save Options on Exit save the current setting of all options in VUEPRINT.INI when the 
program exits.

Default Options set all options to their default values.



JPEG Menu
The JPEG menu provides commands to control the decoding of JPEG files.

Two Pass causes JPEG files to be read in two passes. The first pass analyzes the 
colors, and the second pass reduces the data from 24-bits to 8-bits per 
pixel.    If this option is turned off, the full 24-bits per pixel will be stored
in memory.    If the display has 256 (or fewer) colors, the display will be 
dithered (made up of a pattern of dots).    Note that only 8-bits per pixel
will be kept in memory if the Use Grey Scale option is selected, or if the
JPEG file only has one color component.

Use Dithering enables using Floyd-Steinberg dithering with the two-pass algorithm.

Use Grey Scale enables converting the JPEG file to 8-bits per pixel of grey scale data.

Block Smoothing causes the 8x8 blocks to be smoothed before transforming them from 
the frequency domain.

Pixel Smoothing causes the 8x8 blocks to be smoothes after transforming them from 
the frequency domain.

Write GIF causes a GIF file to be written for every JPEG file that is read.    When 
this option is selected, the two pass algorithm is always used.



Utilities Menu
The Utilities menu provides commands to install and remove VuePrint.

Install VuePrint saves current File Manager associations, sets up associations for 
VuePrint, copies VUEPRINT.EXE and VUEPRINT.HLP to the Windows 
directory, and installs the VuePrint icon in the Accessories window.

Remove VuePrint reverses the above, restoring the system to the original state.    The 
files VUEPRINT.EXE and VUEPRINT.HLP are not deleted and the icon is 
not removed if the running program is running from the Windows 
directory.



Help Menu
The Help menu provides commands for getting help and registering VuePrint.

Contents displays the table of contents of this Help file.

Using Help displays help about the Help program.

About displays information about registering VuePrint, and lets you enter a 
VuePrint serial number.






